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Parallels Client for Windows is an app that allows you to connect to Parallels Remote Application 
Server from a Windows computer. 

In This Chapter 

System Requirements ............................................................................................ 5 
Installing Parallels Client Using an Invitation Email .................................................... 5 
Installing Parallels Client Manually ........................................................................... 8 
 
 

System Requirements 
Parallels Client for Windows has the following software and hardware requirements: 

• Windows XP SP3, Vista, Windows 7, Windows 8, Windows 10. 

• The same hardware requirements as specified by Microsoft for the above versions of Windows. 

• Some features (high color graphics, sound, etc.) will only be available if your Windows computer 
has the appropriate hardware installed and is properly configured. 

 

Installing Parallels Client Using an Invitation Email 
Your Parallels RAS administrator will send you an invitation email with the instructions on how to 
install Parallels Client for Windows and configure a Parallels RAS connection. The invitation email 
will contain the following information and action links: 

• A message from your system administrator. 

• A link to download Parallels Client for Windows (links to Parallels Client for other platforms may 
also be included if you are using other devices in addition to a Windows computer). 

• A link to automatically configure Parallels Client on your computer, so you can connect to the 
Parallels Remote Application Server. 

• Parallels Remote Application Server connection properties. You can use this information to 
manually create a Parallels Remote Application Server connection. The automatic configuration 
via the link (see above) is the preferred and the easiest method, but you can use this information 
to create a connection manually if needed for any reason. 

C H A P T E R  1  

Getting Started 
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Install Parallels Client for Windows 

To install Parallels Client for Windows using an invitation email: 

1 Make sure you are logged into your computer as a user with administrative privileges. 

2 In the invitation email, click the Windows thumbnail to download Parallels Client for Windows 
installer. 

3 When the download is complete, go to your download folder and run the 
ClientDownloader.exe file that you just downloaded. This is actually a small utility that 
detects the version of Windows that you are running and then downloads the appropriate 
Parallels Client for Windows installer. 

4 When the download is complete, the Parallels Client installation wizard will automatically start. 

5 On the Welcome page of the installation wizard, click Next. 

6 Accept the License Agreement and click Next. 

7 Select the folder where you want to install Parallels Client and click Next. 

8 The SSO Installation page will be skipped when installing Parallels Client on a Windows Server 
operating system. On all other supported versions of Windows, it will be shown. Use the page 
to specify whether you want to install the Single Sign-On component. The component will 
automatically use your credentials to connect to Parallels Remote Application Server. Please 
note that for the component to work, you will need to reboot your computer (or log off and then 
log on again) after the installation. 

9 Click Next. 

10 On the Ready to Install page, click Install. 

11 Once the installation is complete, click Finish to close the wizard. 

You now need to configure Parallels Client, so it can connect to Parallels Remote Application 
Server. The invitation email that you received from your system administrator includes a link that 
can accomplish this task automatically. Please follow the instructions below to configure Parallels 
Client. 

Configure Parallels Client for Windows 

To configure Parallels Client: 

1 In the invitation email, find the Configure section and click the Click Here to auto configure 
the downloaded client link. 
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2 The link will open in a web browser after which you should see the following dialog: 

 

3 Make sure the TSClient Application item is selected and click OK. This will configure Parallels 
Client for Windows and then will display the Logon screen. 

 

4 Select the Authentication Type from the following:  

• Credentials. Select this option to connect to Parallels Remote Application Server by 
supplying your credentials, such as your domain user name and password. 

• Smart card. Select this option to connect to Parallels Remote Application Server using a 
smart card. 

• Single Sign-On. This option will be included in the list only if the Single Sign-On module is 
installed during Parallels Client installation. Select this option to use local system credentials 
to connect to the remote server.   
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Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in 
Connection / Authentication. 

5 Depending on the authentication type selected, type your user name and password or insert a 
smart card into a reader. If using a smart card, enter a PIN when prompted. 

6 Click Connect. 

You should now see the main Parallels Client window. The left pane of the window displays the 
connection that was automatically configured for you.The right pane displays published resources 
that you can use.  

 

Double-click a resource to open it. The resource will open in a separate window on your local 
computer as if it was a local application or a document (or a remote desktop if one is available as a 
published resource).  
 

Installing Parallels Client Manually 
The preferred method of downloading and installing Parallels Client for Windows is via an invitation 
email as described in the previous section. If you would like to download and run the installer 
manually, visit https://www.parallels.com/products/ras/download/client. 

To install Parallels Client for Windows: 

1 Make sure you are logged in to your computer as a user with administrative privileges. 
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2 Run the Parallels Client installer that you've downloaded from the Parallels website. 

3 On the Welcome page of the installation wizard, click Next. 

4 Accept the License Agreement and click Next. 

5 Select the folder where you want to install Parallels Client and click Next. 

6 The SSO Installation page will be skipped when installing Parallels Client on a Windows Server 
operating system. On all other supported versions of Windows, it will be shown. Use the page 
to specify whether you want to install the Single Sign-On component. The component will 
automatically use your credentials to connect to Parallels Remote Application Server. Please 
note that for the component to work, you will need to reboot your computer (or log off and then 
log on again) after the installation. 

7 Click Next. 

8 On the Ready to Install page, click Install. 

9 When the installation is complete, click Finish to close the wizard and start Parallels Client for 
Windows. 

 

Connecting to Parallels Remote Application Server 

After you manually install Parallels Client and run it for the first time, you'll be asked if you would like 
to configure a new connection. Click Yes. This will open the New connection dialog. 

 

Your system administrator should give you the connection information that must be specified in this 
dialog. If you received an invitation email from your administrator, you can find this information at 
the bottom of the message. The information will look similar to the following: 

To manually configure the RAS Connection, use the following settings: 
 
Server: 192.168.1.10 
Port: 443 
Connection Mode: Gateway SSL Mode 



10 
 

Getting Started 
 

To specify the connection properties: 

1 In the Server field, enter the Parallels Remote Application Server IP address or hostname (this 
should be the server where the RAS Secure Client Gateway resides). 

2 In the Connection mode field, select one of the following options (note that you should use the 
mode that your system administrator has asked you to use): 

• Direct Mode. Parallels Client first connects to the RAS Secure Client Gateway for the best 
available terminal server and then connects directly to that server.  This is best used when 
the Parallels Client and the terminal server reside on the same network. 

• Direct SSL Mode. Same as the direct mode above, but uses encryption to secure the data. 

• Gateway Mode. Parallels Client connects to the RAS Secure Client Gateway and the 
session connection is tunneled through the first available connection. This mode is ideal for 
servers that are only reachable via the gateway and do not require a high level of security. 

• Gateway SSL Mode. Same as the gateway mode above, but uses encryption to secure the 
data. 

3 In the Friendly name field, choose and type a friendly name for this connection. 

4 If your system administrator told you to specify the port number, do the following: 

a Click the Advanced settings link. The Connection Properties dialog opens (see the 
screenshot below). 

b Specify the port number in the Port field. 

c You can also review and modify other properties if you wish. More on these later in this 
guide. 
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d The [...] button next to the Primary Connection field allows you to select a Parallels RAS 
server (this will only work if the Broadcast RAS Secure Client Gateway Address option 
has been enabled on the server side). 
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5 Click OK. The Logon dialog opens. 

 

6 In the Authentication type drop-down list, select the desired method of authentication: 

• Credentials. Select this option and then enter your username and password. You will be 
authenticated on the remote server using the specified credentials. 

• Smart Card. Select this option to authenticate using a smart card. When connecting to the 
remote server, insert a smart card into the card reader and then enter a PIN when 
prompted. 

• Single Sign-On. This option will be included in the list only if the Single Sign-On module is 
installed during Parallels Client installation. Select this option to use local system credentials 
to connect to the remote server 

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in 
Connection / Authentication. 
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7 Click Connect. If the connection is successful, you'll see the main Parallels Client window 
where your connection(s) and published resources are displayed. 

 
 

Advanced Parallels Client Installation 

Note: This section is intended for IT Administrators. If you are not an IT administrator in your 
organization, you may skip it. 

The Parallels Client for Windows installer uses the MSI format. This enables you to deploy it 
remotely using Group Policies or any other deployment tool that can work with MSI installers. 

There are two ways to modify the client installation settings: 

• Modify the original file using Orca.exe. 

• Run the installer from the command line: msiexec.exe /i RASClient.msi (or 
RASClient-x64.msi if using a 64 bit version)  

Silent Install 

To perform a silent install, run the following command: 

msiexec.exe /qn /i RASClient.msi  
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In the command above, specify RASClient-x64.msi if using a 64 bit version of Parallels Client 
for Windows. 

General Settings 

When running an installation command specified above, you can pass the following properties to 
msiexec.exe using the PROPERTY=VALUE notation: 

DEFSETTINGS: To use when Parallels Client installer reads 2xsetting.2xc (the file containing all 
settings to be used by the client) as default settings. 

DEFSETTXML: To use when XML settings are entered manually. 

OVERRIDEUSERSETTINGS: To override the user settings with client MSI settings. 

• 0 – Client settings are not overridden 

• 1 – Client settings are overridden with the new settings of the Client MSI setup. 

DISABLEOPTIONS: To disable the Options button and hide the options to configure the client 
settings. This option can be applied to users without administrative rights. 

• 0 – Options are enabled 

• 1 – Options are disabled 

DISABLEOPTIONSADMIN: To disable the Options button and hide the options to configure the 
client settings. This option can be applied to users with administrative rights. 

DISABLESAVEPASSWORDADMIN: To disable the clients from saving the password even if they 
have administrative rights. 

• 0 – Option to save password is enabled 

• 1 – Option to save Password is disabled 

DISABLESAVEPASSWORD: To disable the clients from saving the password. This option is ignored 
with users with administrative rights. 

• 0 – Option to save password is enabled 

• 1 – Option to save Password is disabled 

TUXGINA: Exclude/Include SSO during a silent installation 

• 0 – Install SSO 

• 1 – Exclude SSO 

• 2 – Prompt during installation [Default] 

TUXGINASRV: Install SSO on both Client and Server 

• 0 – Install SSO only on the Client 
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• 1 – Install SSO on both Client and Server 

Using Active Directory 

There are two different ways that you can deploy an application through Active Directory. You can 
either publish the application or you can assign the application. 

You can publish applications to users only, but you can assign applications to either users or 
computers. The applications are deployed in different ways, depending on which method you 
decide to use. 

Parallels recommends that administrators assign the applications to COMPUTERS. The main 
reason is that the application is actually installed the next time the computer reboots. 

When assigning to users, the application is not installed until the user actually clicks on the icons 
created for the application. 

To assign an application to certain computers, simply do the following in Active Directory: 

1 Open the Group Policy Editor. 

2 To assign an application to a computer, navigate through the group policy console to Computer 
Configuration / Software Settings / Software Installation. Right-click the Software Installation 
container and click New > Package in the context menu. Select the appropriate MSI file and 
click Open. You are now asked whether you want to publish or assign the application. Select 
Assign and click OK. 

Please note that when doing a silent installation, the MSI can be deployed using the following 
syntax (for the 64 bit version, use RASClient-x64.msi): 

msiexec /qn /i RASClient.msi 

The following sample command installs Parallels Client using the DISABLESAVEPASSWORD=0 
option (enable the ability to save the password)  while skipping the SSO installation: 
msiexec /qn /i 2XClient.msi DISABLESAVEPASSWORD=0 TUXGINA=1 
 



 

 

Read this chapter to learn how to set up Parallels RAS connections, configure preferences, and use 
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Adding a New Connection 
Parallels Client for Windows allows you to have more than one connection, so you could easily 
connect to different servers or using different connection properties, etc. 

To add a connection: 

1 Open Parallels Client by clicking Start > All Apps > Parallels > Parallels Client (or double-
click the Parallels Client icon on your desktop). 

2 In the main Parallels Client window, click the File > New Connection menu item. The New 
Connection dialog opens. 

 

C H A P T E R  2  

Using Parallels Client for Windows 
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3 Specify a connection type that you want to create: 

• Remote Application Server. Create a Parallels Remote Application Server connection. 

• Standard RDP. Create a standard Remote Desktop connection. This option allows you to 
connect to a computer on your network that accepts standard Remote Desktop 
connections. 

4 Click OK. 

5 On the next dialog, specify connection properties: 

 

When creating a Remote Application Server connection, your system administrator should give 
you the connection information that must be specified in this dialog. If you received an invitation 
email from your administrator, you can find this information at the bottom of the message. The 
information will look similar to the following: 

To manually configure the RAS Connection, use the following 
settings: 
 
Server: 192.168.1.10 
Port: 443 
Connection Mode: Gateway SSL Mode 

When creating a Standard RDP connection, you need to know the IP address or hostname of 
the remote computer you want to connect to. 

6 In the Server field, enter the Parallels Remote Application Server IP address or hostname (this 
should be the server where the RAS Secure Client Gateway resides). If creating a Standard 
RDP connection, specify the remote computer IP address or hostname. 

7 The Connection mode drop-down list is enabled only when creating a Remote Application 
Server connection. Select one of the following options (note that you should use the mode that 
your system administrator has asked you to use): 

• Direct Mode. Parallels Client first connects to the RAS Secure Client Gateway for the best 
available terminal server and then connects directly to that server.  This is best used when 
the Parallels Client and the terminal server reside on the same network. 
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• Direct SSL Mode. Same as the direct mode above, but uses encryption to secure the data. 

• Gateway Mode. Parallels Client connects to the RAS Secure Client Gateway and the 
session connection is tunneled through the first available connection. This mode is ideal for 
servers that are only reachable via the gateway and do not require a high level of security. 

• Gateway SSL Mode. Same as the gateway mode above, but uses encryption to secure the 
data. 

8 In the Friendly name field, choose and type a friendly name for this connection. 

9 The Advanced settings link opens the Connection Properties dialog where you can specify 
additional connection properties. For more information, please see Configuring a RAS 
Connection (p. 18) or Configuring an RDP Connection (p. 35). 

10 Click OK to create a connection. 
 

Configuring a RAS Connection 
To view and modify the properties of an existing Remote Application Server connection, right-click 
it in the main Parallels Client window and then click Connection Properties in the context menu. 
This will open the Connection Properties dialog. Properties are grouped in the dialog by 
functionality using tab pages. The following subsections describe each tab page in detail. 
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Connection 

The Connection tab page allows you specify connection properties and logon information. 

 

Configuring the Primary Connection 

On the Connection tab page, you can define a primary connection and one or more secondary 
connections. 

The primary connection is what Parallels Client will use first to connect to the specified server. This 
should be the server where the primary RAS Secure Client Gateway is running.  

To specify the primary connection information: 
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1 In the Primary Connection field, specify the server name or IP address. You can click the [...] 
button and select a server from the list. If the server is not listed, it means that the system 
administrator disabled this functionality on the server side. In such a case, specify the server by 
typing its name or IP address in the Primary Connection field. 

Note for Administrators: The Broadcast RAS Secure Client Gateway Address option must be 
enabled on the server side for the [...] button to display the server. 

2 In the Connection Mode drop-down list, select one of the following options: 

• Gateway Mode: Parallels Client connects to the RAS Secure Client Gateway and the 
session connection is tunneled through the first available connection. This mode is ideal for 
servers which are only reachable via the gateway and do not require a high level of security. 

• Gateway SSL Mode: Same as the gateway mode above, but uses encryption to secure the 
data. 

• Direct Mode: Parallels Client first connects to the RAS Secure Client Gateway for the best 
available terminal server and then connects directly to that particular server.  This is best 
used when the Parallels Client and the terminal server are on the same network. 

• Direct SSL Mode: Same as the direct mode above, but uses encryption to secure the data. 

3 In the Port field, specify the port on which the gateway listens for incoming connections. If the 
default value has been modified on the server side, you have to replace the default value here 
as well. Otherwise, leave the default value intact. 

4 In the Friendly Name field, choose and type a name of your choice, so you could easily identify 
the server in Parallels Client later. 

Configuring a Secondary Connection 

If the server you are connecting to has more than one RAS Secure Client Gateway, you can define 
a secondary connection, which will be used as a backup connection in case the primary 
connection fails. 

To add a secondary connection: 

1 Click the Secondary Connections button. 

2 In the Secondary Connections dialog, click the Add button and specify a server name or IP 
address. This should be a server hosting a secondary RAS Secure Client Gateway (the primary 
gateway is used by the primary connection). You can click the [...] button and select a server 
from the list. If none are available (or if the desired server is not in the list), type the server info in 
the field provided. 

3 Select the connection mode and modify the port number if necessary. Click OK. 

4 Back in the Secondary Connections dialog, you can move connections up or down the list if 
you have more than one. If the primary connection cannot be established, Parallels Client will 
use secondary connections in the order listed. 

5 Click OK. 
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Configuring the Logon Information 

In the Logon section, specify the following properties: 

1 Select the Auto Logon option to enable Parallels Client to connect automatically (using this 
connection) on startup. 

2 In the Authentication type drop-down list, select the desired method of authentication: 

• Credentials: Select this option and then enter the username, password, and domain 
information. You will be authenticated on the remote server using the specified credentials. 

• Smart Card: Select this option to authenticate using a smart card. When connecting to the 
remote server, insert a smart card into the card reader and then enter a PIN when 
prompted. 

• Single Sign-On: This option will be included in the list only if the Single Sign-On module is 
installed during Parallels Client installation. Select this option to use local system credentials 
to connect to the remote server.   

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in 
Connection / Authentication. 

3 Specify your username, password, and the domain name. The Save Password option allows 
you to save your password, so you don't have to enter it every time you connect to the server. 
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Display 

The Display tab page allows you to configure display options. 

 

General Options 

• Color Depth: Specify the desired color depth. 

• Size: This option is available for standard RDP connections only. 

Published Applications 

Use primary monitor only: Display a published resource on the primary monitor only. Other 
monitors connected to the computer will not be used. 
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Desktop Options 

• Smart-sizing. Desktop smart sizing will scale a remote desktop to fit the connection window. 

• Embed desktop in launcher. Enable this option to open a remote desktop inside the Parallels 
Client window (launcher). 

• Span desktop across all monitors. Enable this option to span published desktops across all 
connected monitors. 

• Display connection bar in full screen mode. Enable this option to show the connection bar 
when connecting in full screen mode. 

 
 

Printing 

The Printing tab page allows you to configure printing options. 
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In the Technology drop-down list, select the technology to use when redirecting printers to a 
remote computer: 

• None. Don't redirect printers. 

• RAS Universal Printing technology. Select this option if you want to use RAS Universal 
Printing technology. 

• Microsoft Basic Printing Redirection technology. Select this option if you want to use 
Microsoft Basic printing technology. 

• RAS Universal Printing and Microsoft Basic redirection technologies. Select this option to 
use both Parallels RAS and Microsoft technologies. 

RAS Universal Printing 

If you selected RAS Universal Printing technology, select printers to redirect in the Redirect 
Printers drop-down list:  

• All. All printers on the client side will be redirected. 

• Default only. Only the Windows default printer will be redirected.  

• Specific only. Select the printers to redirect from the provided list. The list becomes enabled 
only if you select this option. 

The Options button opens the RAS Universal Printing Options dialog where you can configure 
additional printing options as described below.  

In the Choose Format drop-down list, select a data format for printing: 

• Print Portable Document Format (PDF). Adobe PDF. This option does NOT require you to 
install any local applications capable of printing a PDF document. All the necessary libraries are 
already installed together with Parallels Client. 

• View PDF with external application. To use this option you must have a local application 
installed which is capable of viewing a PDF document. Note that not all applications are 
supported. For example, the built-in PDF viewer in Windows is not supported, so you must 
have Adobe Acrobat Reader (or a similar application) installed. 

• Print PDF with external application. This option works similar to the View PDF option above. 
It also requires an application capable of printing a PDF document installed locally. 

• Enhanced Meta File (EMF). Use vector format and embedded fonts. 

• Bitmap (BMP). Bitmap images. 

In the Client Printer Preferences section, select one of the following: 

• Use server preferences for all printers. If this option is selected, a generic printer preferences 
dialog will be shown when you click Print in a remote application. The dialog has only a minimal 
set of options that you can choose. 
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• Use client preferences for all printers. With this option selected, a local printer preferences 
dialog will open when you click Print in an application. The dialog will contain a full set of 
options for a particular printer that you have installed on your local computer. If you have more 
than one printer installed, a native preferences dialog will open for any particular printer that you 
choose to print to. 

• Use client preferences for the following printers. You can use this option when you have 
more than one printer installed on your local computer. This option works similar to the Use 
client preferences for all printers option (above), but allows you to select which printers 
should use it. If a printer is not selected, it will use the generic printer preferences dialog, similar 
to the first option in this list. 

Default printer settings 

To configure default printer settings, click the Change Default Printer settings button. 

The default printer list shows printers that can be redirected. The list also includes the printing 
technology which the available printers will use. The technology reflects the setting selected in the 
Technology section. For example, if the technology was set to RAS Universal 
Printing technology, only the printers using RAS Universal Printing will be listed. 

To disable the default printer, select <none>. To redirect the default local printer on the client side 
to the remote computer, select <defaultlocalprinter>. When <custom printer> is selected, you 
can specify a custom printer which might be installed on the remote computer. The first printer that 
matches the printer name inserted in the custom text box, will be set as the default printer on the 
remote computer. 

Select Match exact printer name to match the name exactly as inserted in the custom text box. 
Please note that the remote printer name may be different than the original printer name. Also note 
that local printers may not redirect due to server settings or policies. 

You can specify the time a printer will be forced as default. If the default printer is changed during 
this time after the connection is established, the printer is reset as default. 

Select the Update the remote default printer if the local default printer is changed option to 
change the remote default printer automatically when the local default printer is changed. Please 
note that the new printer must have been previously redirected. 
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Scanning 

On the Scanning tab page, you can specify a specific scanner that should be used when one is 
required by a published resource. 

 

• Use. Allows you to select a scanning technology. RAS Universal Scanning uses TWAIN and 
WIA redirection allowing an application to use either technology depending on the hardware 
type connected to the local computer. If you select None, scanning will disabled. 

• Redirect Scanners. Select scanners attached to your computer for redirection. You can select 
All (all attached scanners will be redirected) or Specific only (only the scanners you select in 
the provided list will be redirected). 
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Local Resources 

Use the Local Resources tab page to configure how local resources are used in a remote session.  

 

Remote Audio 

Click the Settings button to configure remote audio playback and recording options. 

Use the Remote computer drop-down list to select one of the following remote audio playback 
options: 

• Bring to this computer. Audio from the remote computer will play on your local computer. 

• Do not play. Audio from the remote computer will not play on your local computer and will be 
muted on the remote computer as well. 
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• Leave at remote computer. Audio will not play on your local computer but will play normally 
on the remote computer. 

Use the Quality drop-down list to adjust the audio quality: 

• Dynamically adjust based on available bandwidth. This option will increase or decrease the 
audio quality based on your connection speed. The faster the connection, the higher audio 
quality setting will be used. 

• Always use medium audio quality. The audio quality is fixed at the medium level. You can use 
this option when you don't require the best possible audio quality and would rather use the 
available bandwidth for graphics.  

• Always use uncompressed audio quality. The audio quality is fixed at the highest level. 
Select this option if you have a very fast connection and require the best possible audio quality. 

The Recording (if applicable) option allows you to enable audio recording on the remote 
computer. For example, you can speak into a microphone on the local computer and use a sound 
recording application on the remote computer to record yourself. 

Keyboard 

Select how you want to apply key combinations (e.g. Alt+Tab) that you press on the keyboard: 

• On the local computer. Key combinations will be applied to Windows running on the local 
computer. 

• On the remote computer. Key combinations will be applied to Windows running on the 
remote computer. 

• In full screen mode only. Key combinations will be applied to the remote computer only when 
in the full-screen mode. 

Local Devices and Resources 

Choose local disk drives, devices, and other resources that you want to redirect to a remote 
computer. Redirecting a resource makes it available for use in a remote session. For example, a 
redirected local disk drive will be available in a remote application, so you can read from and write 
to it. 

The following options are available: 

• Clipboard. Select this option to enable the local clipboard in a remote session. 

• Disk drives. Select this option and then click Configure Drives. In the dialog that opens, select 
local drives you want to redirect. If you select the Use also disk drives that I plug in later 
option, disk drives that you connect to your local machine later will be automatically available in 
a remote session. 
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• Devices. Select this option and then click Configure Devices. Devices that are currently 
connected to your local computer will appear in the list. This includes supported Plug and Play 
devices, media players based on the Media Transfer Protocol (MTP), and digital cameras based 
on the Picture Transfer Protocol (PTP). If a device is connected to your computer but does not 
appear in the list, it means it is not a supported Plug and Play device. Please note that disk 
drives and smart cards are excluded from this list (you redirect them using dedicated Disk 
drives and Smart cards options). The Show previously connected devices option displays 
devices that are not currently connected but were connected previously. 

• Serial ports. Select this option to redirect serial ports. 

• Smart cards. Select this option to redirect smart cards. 

• Allow file transfer command. Whether to allow remote file transfer. 
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Experience 

The Experience tab page allows you to tweak the connection speed to optimize the performance 
of the connection with the remote server. 

 

In the drop-down list, select your connection speed:  

• If not sure, select the Detect connection quality automatically option. Please note that if you 
select this option, all other options, except Enable Compression, will be disabled and will be 
configured automatically based on the actual connection speed when Parallels Client is 
connected to Parallels RAS. 

• If you select a specific speed (e.g. LAN 10 Mbps or higher), select the desired user experience 
options. If you are connecting to a remote computer on a local network that runs at 100 Mbps 
or higher, it is usually safe to have all of the experience options turned on. Otherwise, select 
only the options that you require. 
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It is also recommended to enable compression to have a more efficient connection by selecting the 
Enable Compression option. 
 

Network 

Use the Network tab page to configure a proxy server if you have to use one to connect to 
Parallels Remote Application Server. 

 

To configure a proxy server, select the Use proxy server option and then select the protocol from 
the following list: 

• SOCKS4. Enable this option to transparently use the service of a network firewall. 

• SOCKS4A. Enable this option to allow a client that cannot connect to resolve the destination 
host’s name to specify it. 

• SOCKS5. Enable this option to be able to connect using authentication. 
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• HTTP 1.1. Enable this option to connect using a standard HTTP 1.1 protocol connection. 

Specify the proxy host domain name or IP address and the port number. 

For SOCKS5 and HTTP 1.1 protocols, select Proxy requires authentication and enter user 
credentials. 
 

Authentication 

Use the Authentication tab page to specify what happens if the server authentication fails. 

 

In the If authentication fails drop-down list, select one of the following options: 

• Connect. The user can ignore the certificate of the server and still connect. 

• Warn. The user is alerted about the certificate and still has the ability to choose whether to 
connect or not. 
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• Do not connect. The user is not allowed to connect. 
 

Advanced Settings 

The Advanced Settings tab page allows you to customize the default behavior or Parallels Client. 

 

You can specify the following properties: 

• Use client system colors. Enable this option to use the client system colors instead of those 
specified on the remote desktop. 

• Use client system settings. Enable this option to use the client system settings instead of 
those specified on the terminal server. 

• Create shortcuts configured on server. For each published application, the administrator can 
configure shortcuts that can be created on the client's desktop and the Start menu. Select this 
option to create the shortcuts, or clear the option if you don't want to create them. 
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• Register file extensions associated from the server. For each published application, the 
administrator can create file extension associations. Use this option to either register the 
associated file extensions or not. 

• Redirect URLs to this computer. Enable this option to use the local web browser when 
opening 'http:" links. 

• Redirect Mail to this computer. Enable this option to use the local mail client when opening 
‘mailto:’ links. 

• Always ask for credentials when starting applications. If this option is enabled, the user will 
be prompted to enter their credentials when starting applications. 

• Allow Server to send commands to be executed by client. Enable this option to allow 
commands being received from the server to be executed by the client. 

• Confirm Server commands before executing them. If this option is enabled, a message is 
displayed on the client to confirm any commands before they are executed from the server. 

• Network Level Authentication. Check this option to enable network level authentication, 
which will require the client to authenticate before connecting to the server. 

• Redirect POS devices. Enables the Point of Service (POS) devices such as bar code scanners 
or magnetic readers that are attached to the local computer to be used in the remote 
connection. 

• Use Pre Windows 2000 login format. If this option is selected, it allows you to use legacy 
(pre-Windows 2000) login format. 

• Disable RDP-UDP for gateway connections. Disable UDP transport when connecting 
through a gateway. 

Connection Advanced Settings 

Click the Connection Advanced Settings button to configure the following settings: 

• Connection Timeout. This is the amount of time during which the client will try to connect to 
Parallels Remote Application Server until the connection is aborted. While the connection is 
being established, the connection banner will be shown. 

• Show Connection Banner if connection is not established within. Specifies the time period 
in seconds after which the connection banner will be displayed. 

• Show Desktop if published application does not start within. If a published application is 
not launched within the time period specified in this field, the server’s desktop will be loaded. 
This is helpful if an error occurs on the server while launching an application. By loading the 
server’s desktop, the error can be seen. 

• Reconnect if connection is dropped. Select this option and set the number of Connection 
Retries. If a connection is dropped, the Parallels Client will automatically try to reconnect. 

• Override computer name. Specifies the name that your computer will use during a remote 
desktop session. If set, this will override the default computer name. Any filtering set by the 
administrator on the server side will make use of the Override computer name. 
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Configuring an RDP Connection 
To modify the properties of an existing standard RDP connection, right-click it in the main Parallels 
Client window and then click Connection Properties in the context menu. This will open the 
Connection Properties dialog. Properties are grouped in the dialog by functionality using tab 
pages. The following subsections describe each tab page in detail. 
 

Connection 

The Connection tab page allows you specify connection settings and logon information. 

 

In the Connection Settings section, specify the following properties: 

1 In the Primary Connection field, specify the remote computer hostname or IP address.  
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2 The Port field contains the TCP port 3389 by default, which is the standard port for RDP 
connections. You can modify it if the port number was changed on the remote computer. 

3 In the Friendly Name field, choose and type a name of your choice, so you could easily identify 
the server in Parallels Client later. 

In the Logon section, specify the following properties: 

1 Select the Auto Logon option to enable Parallels Client to connect automatically (using this 
connection) on startup. 

2 In the Authentication type drop-down list, select the desired method of authentication: 

• Credentials. Select this option and then enter the username, password, and domain 
information. You will be authenticated on the remote server using the specified credentials. 

• Smart Card. Select this option to authenticate using a smart card. When connecting to the 
remote server, insert a smart card into the card reader and then enter a PIN when 
prompted. 

• Single Sign-On. This option will be included in the list only if the Single Sign-On module is 
installed during Parallels Client installation. Select this option to use local system credentials 
to connect to the remote server. 

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in 
Connection / Authentication. 

3 Specify your username, password, and the domain name. The Save Password option allows 
you to save your password, so you don't have to enter it every time you connect to the server. 
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Display 

The Display tab page allows you to configure display options. 

 

In the General Options section, specify the general display properties, including color depth and 
screen size. If you would like to specify a custom screen size, select Custom in the drop-down list 
and then specify the size using the Width and Height fields. 

If you have more than one monitor connected to your computer, select the Use all monitors for 
Desktop session option to use all of them to display the remote desktop. 

Specify the Desktop Options as follows: 

• Smart-sizing. Desktop smart sizing will scale the RDP desktop to fit the connection window. 

• Embed desktop in launcher. Enable this option to access the published desktop inside 
Parallels Client. 
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• Span desktop across all monitors. Enable this option to span the published desktops across 
all connected monitors (if you have more than one). 

• Display connection bar in full screen mode. Enable this option to show the connection bar 
when connecting in full screen mode. 

 

Local Resources 

Use the Local Resources tab page to configure how local resources are used in a remote session.  

 

Remote Audio 

Click the Settings button to configure remote audio playback and recording options. 

Use the Remote computer drop-down list to select one of the following remote audio playback 
options: 
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• Bring to this computer. Audio from the remote computer will play on your local computer. 

• Do not play. Audio from the remote computer will not play on your local computer and will be 
muted on the remote computer as well. 

• Leave at remote computer. Audio will not play on your local computer but will play normally 
on the remote computer. 

Use the Quality drop-down list to adjust the audio quality: 

• Dynamically adjust based on available bandwidth. This option will increase or decrease the 
audio quality based on your connection speed. The faster the connection, the higher audio 
quality setting will be used. 

• Always use medium audio quality. The audio quality is fixed at the medium level. You can use 
this option when you don't require the best possible audio quality and would rather use the 
available bandwidth for graphics.  

• Always use uncompressed audio quality. The audio quality is fixed at the highest level. 
Select this option if you have a very fast connection and require the best possible audio quality. 

The Recording (if applicable) option allows you to enable audio recording on the remote 
computer. For example, you can speak into a microphone on the local computer and use a sound 
recording application on the remote computer to record yourself. 

Keyboard 

Select how you want to apply key combinations (e.g. Alt+Tab) that you press on the keyboard: 

• On the local computer. Key combinations will be applied to Windows running on the local 
computer. 

• On the remote computer. Key combinations will be applied to Windows running on the 
remote computer. 

• In full screen mode only. Key combinations will be applied to the remote computer only when 
in the full-screen mode. 

Local Devices 

Choose local disk drives, devices, and other resources that you want to redirect to a remote 
computer. Redirecting a resource makes it available for use in a remote session. For example, a 
redirected local disk drive will be available in a remote application, so you can read from and write 
to it. 

The following options are available: 

• Clipboard. Select this option to enable the local clipboard in a remote session. 

• Disk drives. Select this option and then click Configure Drives. In the dialog that opens, select 
local drives you want to redirect. If you select the Use also disk drives that I plug in later 
option, disk drives that you connect to your local machine later will be automatically available in 
a remote session. 
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• Devices. Select this option and then click Configure Devices. Devices that are currently 
connected to your local computer will appear in the list. This includes supported Plug and Play 
devices, media players based on the Media Transfer Protocol (MTP), and digital cameras based 
on the Picture Transfer Protocol (PTP). If a device is connected to your computer but does not 
appear in the list, it means it is not a supported Plug and Play device. Please note that disk 
drives, printers, and smart cards are excluded from this list (you redirect them using dedicated 
Disk drives, Printers, and Smart cards options). The Show previously connected devices 
option displays devices that are not currently connected but were connected previously. 

• Serial ports. Select this option to redirect serial ports. 

• Smart cards. Select this option to redirect smart cards. 

• Printers. Select this option to redirect local printers. 
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Programs 

The Programs tab page allows you to specify a program that will be started automatically on the 
remote computer when you establish a connection with it. 

 

Select the Start the following program on connection option and then specify the Program path 
and file name and Start in the following folder option, if needed. 
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Experience 

The Experience tab page allows you to tweak the connection speed to optimize the performance 
of the connection with the remote server. 

 

In the drop-down list, select your connection speed:  

• If not sure, select the Detect connection quality automatically option. Please note that if you 
select this option, all other options, except Enable Compression, will be disabled and will be 
configured automatically based on the actual connection speed when Parallels Client is 
connected to Parallels RAS. 

• If you select a specific speed (e.g. LAN 10 Mbps or higher), select the desired user experience 
options. If you are connecting to a remote computer on a local network that runs at 100 Mbps 
or higher, it is usually safe to have all of the experience options turned on. Otherwise, select 
only the options that you require. 
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It is also recommended to enable compression to have a more efficient connection by selecting the 
Enable Compression option. 
 

Network 

Use the Network tab page to configure a proxy server if you have to use one to connect to the 
remote computer. 

 

To configure a proxy server, select the Use proxy server option and then select the protocol from 
the following list: 

• SOCKS4. Enable this option to transparently use the service of a network firewall. 

• SOCKS4A. Enable this option to allow a client that cannot connect to resolve the destination 
host’s name to specify it. 

• SOCKS5. Enable this option to be able to connect using authentication. 
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• HTTP 1.1. Enable this option to connect using the standard HTTP 1.1 protocol connections. 

Specify the proxy host domain name or IP address and the port number. 

For SOCKS5 and HTTP 1.1 protocols, select Proxy requires authentication and enter user 
credentials. 
 

Authentication 

Use the Authentication tab page to specify what happens if server authentication fails. 

 

In the If authentication fails drop-down list, select one of the following options: 

• Connect. The user can ignore the certificate of the server and still connect. 

• Warn. The user is alerted about the certificate and still has the ability to choose whether to 
connect or not. 
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• Do not connect. The user is not allowed to connect. 
 

Advanced Settings 

The Advanced Settings tab page allows you to customize the default behavior or Parallels Client. 

 

You can specify the following properties: 

• Connect to console. This option is used for administration of a Remote Desktop Session Host 
server. It acts as if a standard Remote Desktop connection is initiated from the command line 
with the /admin option. 

• Network Level Authentication. Select this option to enable network level authentication, which 
will require the client to authenticate before connecting to the server. 

• Redirect POS devices. Enables the Point of Service (POS) devices such as bar code scanners 
or magnetic readers that are attached to the local computer to be used in the remote 
connection. 
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• Use Pre Windows 2000 login format. If this option is selected, it allows you to use legacy 
(pre-Windows 2000) login format. 

Connection Advanced Settings 

Click the Connection Advanced Settings button to open the Connection Advanced Settings 
dialog. 

In the Connection section, specify the following properties: 

• Connection Timeout. The amount of time Parallels Client will try to connect to the remote 
computer until the connection is aborted. While the connection is being established, the 
connection banner will be shown. 

• Show Connection Banner if connection is not established within. Specifies the time period 
in seconds after which the connection banner will be displayed. 

In the Reconnection section, specify the following properties: 

• Reconnect if connection is dropped. Select this option and set the number of Connection 
Retries. If a connection is dropped, the Parallels Client will automatically try to reconnect. 

• Show Connection Banner if reconnection is not established within. Specifies the time 
period in seconds after which the connection banner will be displayed. 

Override computer name. Specifies the name that your computer will use during a remote 
desktop session. If set, this will override the default computer name. Any filtering set by the 
administrator on the server side will make use of the Override computer name. 
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Configuring Global Options 
To configure Parallels Client global options, click Tools > Options in the main menu. 

 

General 

On the General tab page, specify the following options: 

• Connection Banner. Connection banner is shown when the Parallels Client is connecting to a 
server or a desktop. You can choose to have a Splash Window, a Taskbar Toast Window icon, 
or you can choose to hide the connection banner. 

• Automatically refresh connected RAS connection every. Specifies the auto refresh time 
frame for each connection. 

• Logging. Enables or disables extended logging and allows you to view or clear the log file. 
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• Check for updates on startup. This option is available only with administrative rights. If this 
option is selected, Parallels Client will check for available Parallels Client updates on startup. 
You can also click the button to check for updates. 

Single Sign-On 

 

On the Single Sign-On page, specify the SSO settings if your organization is using it.  

1 Click the Enable button to enable SSO. 

2 If your organization is using a third-party SSO component (other than the one provided by 
Parallels RAS), select the Force to wrap third party SSO component option and then select 
the provider.  

3 The Copy GUID to Clipboard button is used to copy the ID of the SSO component to the 
clipboard. 
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Advanced Settings 

The Advanced Settings tab page allows you to configure advanced options. 

 

The following advanced options are available: 

• Hide Launcher when application is launched. If this option is enabled, the launcher will be 
minimized to the system tray after an application is launched. 

• Always on Top. With this feature enabled, other applications will no longer mask the launcher. 

• Do not warn if server certificate is not verified. When connected over SSL, and the 
certificate is not verified, a warning message will be displayed. You can disable this warning 
message by enabling this option. 

• Show folders page. Enabling this option will show the available folders while showing the 
hierarchy of the application groups as configured on the server. 

• Minimize to tray on close or escape. Enable this feature to place the Parallels Client into the 
System Tray when you click on the Close button or hit escape. 
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• Launch automatically at Windows startup. This option will place a shortcut in the start menu 
folder of the client and the Parallels Client will launch automatically on Windows startup. 

• Add RAS Connection automatically when starting web or shortcuts items. This option will 
add the connection preferences in the Parallels Client when starting an item contained in a 
connection that is not yet listed. 

• Don't show prompt message for auto add RAS Connections. Enable this option to disable 
prompt messages when adding auto connections. 

• Clear session cookies on exit. When a user logs on, a Parallels Remote Application Server 
logon cookie is kept on the client side. This will allow the user to connect again with Remote 
Application Server without re-authenticating. Check this option to delete any cookies when the 
user closes the Parallels Client. 

• Close error messages automatically. When a session disconnects because of an error, the 
error is automatically dismissed after 15 seconds. 

• Automatic fonts installed (administrators only). If automatic fonts are installed on the server, 
they will be available when a session connects. 

• Swap Mouse Buttons. When enabling this setting, the mouse buttons will be swapped on the 
remote computer. 

• Redirect vendor paper sizes for RAS Universal Printing. When enabling this setting, non-
standard paper sizes which are not included in the standard options will be redirected to the 
client. Sizes may vary depending on the vendor. 

• Raw printing support. When enabling this setting, printing will still work for applications 
sending data in RAW format. 

• Convert non distributable fonts data to images. During RAS Universal Printing, if a 
document includes non-distributable fonts, each page is converted to an image. 

• Cache printers hardware information. Caching of printer hardware information locally to 
speed-up RAS universal printer redirection. 

• Cache RAS Universal Printing embedded fonts. Caching of embedded fonts locally to 
speed-up RAS universal printing process time. 

• DPI aware. This will force a published application to be DPI-aware depending on the client's 
DPI settings. This feature works on Windows 8.1 or higher. 

 

Using a RAS Connection 
To connect to Parallels Remote Application Server, double-click a connection in the Connections 
list (or right-click a connection and choose Connect). You can have multiple active connections at 
the same time. To switch between active connections, click a connection in the left or the right 
pane. 
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Launching Published Resources 

After you connect to a remote server, the connection node is populated with published folders. 
When you select a folder in the left pane, the resources that it contains are displayed in the right 
pane. If your administrator hasn't published any folders, then the available resources are displayed 
when you select the connection itself. 

 

To launch a resource, double-click it in the right pane. The resource will open on your Windows 
desktop. You can also open a resource by selecting it in the right pane and then clicking 
Applications > Open in the main menu. 

By default, Parallels Client is configured to minimize to the system tray when you launch a resource. 

To bring it back up, open the system tray, then right-click the Parallels Client icon  and choose 
Restore. To change this default behavior, click Tools > Options in the main menu, then select the 
Advanced Settings tab and clear the Hide Launcher when application is launched option. 

You can navigate and customize the published resources view as follows: 

• Use the arrows at the top of the left pane to navigate the Connections tree left, right, or up. 

• Expand an active connection node to view published folders (when they are available). 

• Click a part of the navigation string (e.g. Connections > My RAS Connection > Applications) to 
display the corresponding tree node. 
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• Click the recycle icon to refresh the published resources view. If there were changes on the 
server side, they will be reflected in Parallels Client. 

• Use the Search box to search for a resource. The list will be filtered as you type. To remove the 
filter, clear the box. 

• Use the View menu item to display published resources as icons, tiles, list, etc. To quickly 
switch between icons and a detailed list, click one of the two icons in the lower right corner of 
the main window. 

 

Working with Remote Applications 

When a remote application is launched on your PC, you can work with it just like with a local 
application, which means that you can perform any of the following actions: 

• Open local files in the application. 

• Create new files and save them locally. 

• Maximize and minimize the application (if it has the controls for it in general). 

• Move the application around Windows desktop. 

• Print documents or graphics to a local printer. 

• Use a scanner connected to your PC. 

• Beginning with Parallels RAS v16.2, you can drag and drop files to remote applications. For 
example, you can drag and drop a local file to a remote application to open it, or you can drag 
and drop a file to Windows Explorer running remotely to copy it. Some limitations apply, so it 
may not work for all types of files and applications. For example, you cannot drag and drop 
OLE objects, and some others.  

In other words, a remote application gives you full control and is no different from an application 
running locally on your PC. 
 

Managing Shortcuts 

After establishing a connection with Parallels RAS and retrieving the list of the available published 
resources, you can create a shortcut for a remote application or desktop on your local Windows 
desktop. 

To manage shortcuts, click the Applications menu item and choose one of the following items: 

• Create Shortcut on Desktop. Create a shortcut on the local desktop for the selected 
published resource. 

• Create Shortcut for All Visible Applications. Create shortcuts on the local desktop for all 
resources displayed in the right pane. 

• Delete Shortcuts From Desktop. Delete all shortcuts from the local desktop. 
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Managing Sessions 

When you launch a remote application or desktop in Parallels Client, a session is created for the 
connection. You can manage sessions from the Sessions menu, which allows you to perform the 
following tasks: 

• Connect. Connect to Parallels RAS using the selected connection settings. If the selected 
connection is active, this menu item is disabled. 

• Refresh. Refresh the published resources view (the information is re-retrieved from Parallels 
RAS). 

• Log Off. End the remote session. 

• Send Ctrl-Alt-Del. Send the key combination to the remote server. 

• Session Information. View and manage active session(s). See below for more information. 

• Disconnect All RAS Sessions. Disconnect all active Parallels Client sessions. The 
corresponding sessions running on the remote server continue to run. 

• Log Off All RAS Sessions. Logs off all active sessions on the local and the remote computer. 
 

Assessing Network Performance 

When users experience poor performance while working with remote applications or desktops in 
Parallels Client, the issue may not be related to back-end Parallels RAS components, but simply 
due to poor network conditions. Parallels Client provides you with the ability to assess network 
performance while an active session is running. 
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To asses network performance, click Sessions > Session Information in the main menu. The 
Sessions dialog opens where you can view active session information. 

 

The columns in the Sessions table are: 

• Session. Session name. 

• Server. Remote server name or IP address. 

• Connection Quality. Can be one of the following: Poor, Fair, Good, Excellent. 

• Latency. Connection round-trip delay time, in milliseconds. 

• Bandwidth. Connection bandwidth. 

• Username. Username of the session owner. 

• Domain. Domain name. 

• Type. Connection type (RAS or RDP). 

The Connection Quality, Latency, and Bandwidth column values should give you enough 
information to identify poor network conditions. If network performance is not as expected, you can 
address the issue from this perspective. You can also view the connection quality information on 
the Session Information dialog (Connection Quality section). To open the dialog, select a session 
and click the Show Information button. 

The buttons in the Sessions dialog allow you to perform the following actions: 
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• Refresh. Refresh the Sessions list. 

• Show Information. Display additional session information.  

• Disconnect. Disconnect from Parallels RAS. The resource (or resources) will be closed on your 
local desktop, but will continue to run on the remote server. If you open the resource after that, 
your work will be where you left it. If you had more than one instance of a resource opened 
before you disconnected from Parallels RAS, all of them will open on your desktop. 

• Logoff. End the session. This will close all running resources on the remote server. You should 
save all your data before ending a session. 

• Close. Close the Sessions dialog. 
 

Changing Domain Password 

If you need to change your domain account password, you can do it right from Parallels Client.  

Note: If your domain password will expire soon, you will see a notification in the Windows taskbar (above 
the Parallels Client icon) when you connect to Parallels RAS. To change your domain password at that 
time, click on the notification itself, which will open the Change Domain Password dialog, or you can 
close the notification and change the password later as described below. 

To change your domain password (if required or for any other reason): 

1 Click File > Change Domain Password in the main menu (or right-click a connection and 
choose Change Domain Password). 

2 In the Logon dialog, type your current password and click OK. 

3 In the Change Password dialog, enter a new password in both fields and click OK. 

Your domain account password is now changed. Your existing connections in Parallels Client are 
automatically updated to use the new password. 
 

Using an RDP Connection 
After adding a Standard Remote Desktop connection, double-click it (or right-click > Connect) to 
establish a connection with the remote computer. 

You can have multiple active connections at the same time (both standard RDP and Remote 
Application Server). To switch between active connections in Parallels Client, click a connection in 
the left pane or click the corresponding tab page in the right pane. 

Right-click an active RDP connection in the Connections list to perform the following actions: 

• Connect. This item is disabled for an active connection. 

• Connection Properties. Opens the Connection Properties dialog where you can configure the 
connection. See Configuring an RDP Connection for details (p. 35). 
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• Smart Sizing. If enabled, smart-sizing will resize the remote desktop so it fits the available area. 

• Embed in Launcher. Click this item to move the remote desktop to a new window (it will float 
outside the main Parallels Client window). To return the remote desktop back to the Parallels 
Client window, click the menu item again. 

• Create Shortcut on Desktop. Creates a shortcut for this connection on the local desktop. 

• Delete Shortcut from Desktop. Removes the connection shortcut from the desktop.  

• Disconnect. Disconnects the selected connection. 

• Delete. Deletes the connection. 
 

Exporting and Importing Parallels Client Settings 
You can export current Parallels Client settings to a file to have a backup or to import the settings 
into Parallels Client installed on a different computer. The following settings are exported: 

• All existing connections including all individual connection properties. 

• Parallels Client global options. 

To export the current Parallels Client settings to a file, click File on the main menu and then click 
Export Settings. In the dialog that opens, specify a file name and a destination folder. Click Save 
to export the settings. The file is saved with the ".2xc" extension. 

To import the settings, click File > Import Settings. In the dialog that opens, select the ".2xc" file 
and click Open. Please note that the Parallels Client settings stored in a file will override the current 
Parallels Client settings. 
 

Parallels Client Command Line Parameters 
Parallels Client for Windows parameters are available when launching published application and 
published desktop from the command line. 

Parameters Note 

s!='primary server' Primary Server hostname or IP address. 

b!='backup server' Secondary Server hostname or IP address. 

a!='application/desktop id' Published Application/Desktop ID. 

p!='override application params'  

t!='port' Port of the RAS Remote Application 
Serverconnection. 

u!='username' Username for the user to connect with. 

q!='password' Password for the user. 

d!='domain' ignored if user name is in UPN format Domain name. 
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l!='0/1' 0 use primary server, 1 user backup server Specify value  in order to connect either to primary 
or backup server. 

m!='connection mode' (gateway mode = 0, direct 
mode 1, gateway ssl mode = 2, direct ssl = 3, 
direct rdp=4) 

Specify value for  the connection mode. 

o!='0/1' if set to 1 credentials are overwritten with 
SSO information if available 

When set to 1, credentials are overwritten with 
SSO credentials. 

i!='connection alias' Specify a connection Alias. 

c! Always ask for credentials. 

r! Reconnect if connection is dropped . 

Example: 

1 In Command Prompt, go to the location were Parallels Client is installed and run the following 
command: 

TSClient.exe s!='2008ad1.2x.testing' a!='#50' t!='80' d!='2x.testing' 
u!='testerjm'q!='123456'  m!='0' 

Running the above command will launch Published application with ID92, for user testerjm. 
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